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Overview 

Stellar DBX to PST Converter converts Microsoft Outlook Express (DBX) files to Microsoft Outlook (PST) 

file. The application scans and converts a single DBX or a complete mailbox with multiple DBX files. After 

scanning, the software shows the preview of mails. 

What's new in this version? 

 Support for MS Outlook 2016 

Key Features of Stellar DBX to PST Converter are as follows: 

 User friendly and secure software. 

 Converts Microsoft Outlook Express (DBX) files to Microsoft Outlook (PST) file. 

 Find feature to search for Microsoft Outlook Express (DBX) files. 

 Provides preview of mails. 

 Log Report. 

 

 

  



Installation Procedure 

Before installing the software, check that your system meets the following minimum system requirements: 

Minimum System Requirements 

Processor: Pentium Class 

Operating System:Windows10 / Windows 8.1 / Windows 8 / Windows 7 / Windows Vista 

Memory: Minimum 1 GB 

Hard Disc: 100 MB free space 

MS Outlook: 2016 / 2013 / 2010 / 2007. 

To install the software, follow these steps: 

1. Double-click StellarDBXtoPSTConverter.exe executable file to start installation. Setup - Stellar 

DBX to PST Converter dialog box is displayed.  

2. Click Next. License Agreement dialog box is displayed. 

3. Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

4. Click Browse to select the destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder dialog box is displayed. 

5. Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog 

box is displayed. 

6. Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed.  

7. Review the entries. Click Back if you want to change them. Click Install to start installation. The 

installation window shows the progress. 

8. After completing the process, Completing the Stellar DBX to PST Converter Setup Wizard 

window is displayed. Click Finish. 

9. Clear Launch Stellar DBX to PST Converter check box to stop automatic launch of software. 

 

Note: Clear Launch Stellar DBX to PST Converter check box before clicking Finish to prevent the 

software from launching. 

  



Launching the software 

To launch Stellar DBX to PST Converter in Windows 10: 

 Click Start icon -> All apps -> Stellar DBX to PST Converter  -> Stellar DBX to PST Converter 

 Or, 

 Double click Stellar DBX to PST Converter icon on the desktop. Or, 

 Click Stellar DBX to PST Converter tile on the home screen. 

 

To launch Stellar DBX to PST Converter in Windows  8.1 / 8: 

 Click Stellar DBX to PST Converter tile on the home screen. Or, 

 Double click Stellar DBX to PST Converter icon on the desktop. 

 

To launch Stellar DBX to PST Converter in Windows 7 / Vista: 

 Click Start -> Programs -> Stellar DBX to PST Converter -> Stellar DBX to PST Converter. Or, 

 Double click Stellar DBX to PST Converter icon on the desktop. Or, 

 Click Stellar DBX to PST Converter icon in Quick Launch. 

  



User Interface 

Stellar DBX to PST Converter software has a very easy to use Graphical User Interface. The user 

interface contains features required for conversion. 

After launching the program, you will see the main user interface as shown below: 

 

The user interface contains menus and buttons that lets you access various features of the software with 

ease. 

  



Menus 

File Menu 

 

Select DBX 

Use this option to select .DBX file, identity 

folder. 

 

Save 

Use this option to save converted mails 

after scanning. 

View Menu 

 

Log Report 

Use this option to view the log window. 

Tools Menu 

 

Update Wizard 

Use this option to update your copy of 

Stellar DBX to PST Converter. 

Registration Menu 

 

Register 

Use this option to register your copy of the 

software. 

 

Transfer License 

Use this option to transfer the license of 

the registered software to another 

computer. 

Help Menu 



 

Help 

Use this option to see user help guide. 

 

Order 

Use this option to buy Stellar DBX to PST 

Converter. 

 

Support 

Use this option view the support page of 

stellarinfo.com 

 

Knowledgebase 

Use this option to visit Knowledgebase 

articles of stellarinfo.com 

 

Enquiry 

Use this option to submit enquiry to 

stellarinfo.com 

 

About 

Use this option to read information about 

the software. 

Style Menu 

 

Style 

Use this option to switch between various themes 

for the software, as per your choice. Stellar DBX 

to PST Converter offers the following themes: 

Blue Style, Black Style, Silver Style and Aqua 

Style. 
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Buttons 

The user interface of Stellar DBX to PST Converter has the following buttons: 

 

Select DBX 

 

Click this button to open Select DBX File dialog box. 

 

Save 

 

After scanning, click this button to go through the process of saving converted 

mails. 

 

Support 

 

Click this button to open Stellar Information Technology Private Limited's online 

support website. 

 

Help 

 

Click this button to access user guide if you face any issue while using the 

product. 

 

Knowledgebase 

 

Click this button to view knowledgebase articles of stellarinfo.com 

 

Enquiry 

 

Click this button to submit an enquiry to stellarinfo.com 

 

Log Report 

 

Click this button to view the log report, which contains the details of the 

conversion process. 



 

Register 

 

Click this button to register the software after purchasing. 

 

Update Wizard 

 

Click this button to check for both latest minor and major version available 

online. 

 

Order 

 

Click this button to go through the purchasing process. 

 

About 

 

Click this button to know the version of the software, operating system it 

supports, service pack number of the operating system, etc. 

  



Ordering the Software 

To know more about Stellar DBX to PST Converter, click here. 

To purchase the software online, please visit https://www.stellarinfo.com/email-repair/dbx-pst-
converter/buy-now.php 

Alternatively, click on Purchase icon in Support Menu on Menu Bar to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 
to activate the software. 
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Registering the Software 

The demo version is just for evaluation purpose and must be eventually registered to use the full 

functionality of the software. The software can be registered using the Registration Key which you will 

receive via email after purchasing the software.  

To register the software: 

1. Run demo version of Stellar DBX to PST Converter software. 

2. On Registration menu, click Register option. Register window is displayed as shown below. 

 

3. Choose ’I don’t have the registration key’ (Use this option if you have not purchased the product) 

or select ’I have the registration key’ (Use this option if you have already purchased the product). 

To register the software, when you do not have a registration key, follow the steps given below: 

1. In the Register window, select 'I don't have the registration key' option. Click OK, to go online 

and purchase the product. 

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of 

purchase.  

3. In the Online Registration window, type the Registration Key and click Register button (Please 

ensure that you have an active Internet connection). 



 

4. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK.  

To register the software, when you have a key, follow the steps given below: 

1. In the Register window, select 'I have the registration key' option. 

2. You can choose either 'Online Registration' (Use this option to register the software over Internet) 

or 'Offline Registration' (Use this option to register the software manually / through e-mail if for 

any reason, Internet connection is unavailable). 

 Online Registration 

Online Registration is possible only when an active Internet connection is available. 

o To register the software online: 

1. From the Register window, select Online Registration. Click OK.  

 

2. An Online Registration dialog box will appear. 

3. Type the Registration Key (received through email after purchasing the product) in the 

field of Registration Key. Click Register. 



 

4. The software would automatically communicate with the license server to verify the 

entered key. If the key you entered is valid, software will be registered successfully. 

 Offline Registration 

Offline Registration enables you to register the product when your computer does not have an 

Internet connection. 

o To register the software offline: 

1. From the Register window, select Offline Registration. Click OK.  

 

2. An Offline Registration dialog box will appear displaying Registration ID in its 

respective field. 



 

3. To get your License Key, which is required to register the software manually, you need to 

mail the listed Registration ID to support@stellarinfo.com. 

4. A License Key will be sent to your email address after verifying the Registration ID and 

purchase details by Stellar Technical Support. 

5. After receiving the License Key, open Stellar DBX to PST Converter. In Register 

window, select 'I have the registration key'. 

6. Select Offline Registration and click OK. 

7. Enter the License Key received through email in the field of License Key.  

 

8. Click Register to activate the software. A confirmation message is displayed if a valid key 

is entered. Click OK. 
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Transfer License 

Stellar DBX to PST Converter allows you to transfer the license of the registered software to another 
computer on which you want to run the software with full functionality. This operation deactivates the 
product on your current computer so it can be reactivated on the new computer.  

To transfer a software license from one computer to another, please follow the specific steps 
below: 

On Target Computer:  

1. Run demo version of the software. 

2. In Registration Menu on Menu Bar, click Register. A new dialog appears. 

3. From the Register window, select Offline Registration. Click OK.   

4. An Offline Registration dialog box will appear displaying Registration ID in its respective field. 

 

On Source Computer: 

1. Run registered version of Stellar DBX to PST Converter software. 

2. In Registration Menu on Menu Bar, click Transfer License. 

 

3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on the 

Source Computer. 



4. To get your License Key, click Transfer In button on Source Computer. This will generate a 

License Key. 

 

5. You can also save the License Key generated on the source computer. Click Save to File button 
to save the Registration ID and the License Key. In Browse for Folder dialog box, select the 
location where you want to save the details. Click OK. 

6. 'License Key has been saved successfully' message is displayed after the saving process is 
completed successfully. Click OK. 

 

This will deactivate the product on Source Computer and you will no longer be able to use the software 
anymore on this computer. 

On Target Computer: 

1. Type the License Key which you have generated on the Source Computer in the provided field of 

License Key. 

 

2. Click Register to complete the activation process.  

3. 'Activation Completed Successfully' message is displayed after the process is completed 
successfully. Click OK. 

 



Updating the Software 

There are periodical software updates for Stellar DBX to PST Converter. The software updates should 

be done to keep the software up-to-date. The updates can be a newly added functionality, a new feature, 

a new service or any other information that can be important for improvement. Update option in the 

application is capable of checking for the latest updates. This will check for both latest minor and major 

version available online. You can easily download minor version through the update wizard. However, the 

major version, if available, has to be purchased. While updating the software, it’s recommended to close 

all the running programs. Note that demo version can not be updated. 

To update the application, follow the steps given below: 

1. Click on Update Wizard button from the Tools menu bar. Update Wizard is displayed. 

2. Click Next. A busy timer shows that updates are being searched. If it finds any new version, a 

message indicates the availability. 

3. If a message is displayed that no updates are available, click Cancel to close the wizard. 

4. Click Next. The software will start downloading the update files from the server. When the 

process is complete, the software will upgrade to the latest version.  

 

  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at http://www.stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/email-repair/dbx-pst-

converter/buy-now.php 

Chat Live with an Online technician at http://stellarinfo.com/support/ 

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

Send e-mail to Stellar Support at support@stellarinfo.com 

Support Helpline 

Monday to Friday [ 24 Hours a day ] 

USA (Toll free Pre Sales Queries) +1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales Support +31-208-111-188 

Worldwide +91-124-432-6777 

Email Orders   orders@stellarinfo.com 

http://www.stellarinfo.com/support/
https://www.stellarinfo.com/email-repair/dbx-pst-converter/buy-now.php
https://www.stellarinfo.com/email-repair/dbx-pst-converter/buy-now.php
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Convert Entire Mailbox to PST File 

To covert an entire mailbox to PST file, follow the steps given below: 

1. Choose Convert / Migrate entire mailbox to MS Outlook PST in Select DBX File dialog box as 

shown below: 

 

2. Select DBX File dialog box is opened when you  

i. Launch the application. 

ii. Choose Open DBX File option from the File menu. 

iii. Click Open DBX File button on the toolbar. 

3. Click on Select Identity Folder button from the Select DBX File dialog box and locate identity 

folder in Browse dialog box. The software will display the list of DBX files found in the identity 

folder as shown below: 



 

4. Click Start Conversion button to start the scanning process. 

Note: The default location of Identity Folder on Windows XP system is -> C:\Documents and 

Settings\Administrator\Local Settings\Application Data\Identities\Microsoft..... 

  



Convert Single DBX file to PST File 

To convert a single DBX file to a PST file, follow the steps given below: 

1. Choose Convert / Migrate single DBX file to MS Outlook PST in Select DBX File dialog box 

as shown below: 

 

2. Select DBX File dialog box is opened when you 

i. Launch the application. 

ii. Choose Open DBX File option from the File menu. 

iii. Click Open DBX File button on the toolbar. 

3. Click Select DBX button and locate DBX file in Open dialog box. After selection, Start 

Conversion button is enabled. 

4. Click Start Conversion button to start the scanning process. 

  



Find DBX Files 

To search for DBX files on your computer, you can use the Find DBX button. 

To search for DBX files on your computer, follow the steps given below: 

1. Click Find DBX button in Select DBX File dialog box. The Find DBX dialog box opens as shown 

below: 

 

2. Select drive to be searched for DBX files in Look in drop down box and click Start button. The 

application starts searching for DBX files and displays list of files found after finishing the search. 

3. Select the desired DBX file and click OK. 

4. Click Start Conversion button in Select DBX File dialog box to start conversion process. 

  



Preview Mails 

After scanning is completed successfully, the application displays mailbox folders in left pane of the user 

interface. Click on any folder to see its mails in upper right pane. To see content of desired mail, click on it 

in upper right pane. The content is displayed in lower right pane as shown below. 

 

  



Save Converted File 

To save the converted mails, follow the steps given below: 

1. Click on the desired mail item folder in the left pane to select it. 

2. Click on Save Mails button on the toolbar or select Save Mails option from File menu. 

3. Save File Option dialog box will open as shown below. 

 

4. To append the converted mails to an existing MS Outlook profile, follow the steps given below: 

i. By default, Append data to existing profile radio option is selected and all MS Outlook 

profiles are displayed. You can select any one of them. 

ii. Click OK. 

The converted mails will be added to the existing MS Outlook profile. 

Or, 

4. To save converted mails to a new PST file, follow the steps given below: 

i. Select Create New PST File and click Browse button. 

ii. Browse For Folder dialog box opens. Select location for saving PST file and click OK. 



iii. Click OK. 

The converted mails will be saved into a new PST file at the specified location. 

Or, 

4. To save converted mails to an existing PST file, follow the steps given below: 

i. Select Save Data to existing PST File and click on Browse button. 

ii. Browse For Folder dialog box opens. Select an existing PST file in Open dialog box. 

Click Open. 

iii. Click OK. 

The converted mails will be saved into the selected PST file. 

 

Note: In demo version of the software, you can only view and save the subject and body of the mails but 

cannot open any of the mail's attachments. All other fields have DEMO written in it. 

  



Import PST File in MS Outlook 

To import PST file in Microsoft Outlook 2016 / 2013: 

 Open Microsoft Outlook. From File Menu, select Open & Export.  

 Select Import / Export option from the right pane. 

 From Import and Export Wizard window, select Import from another program or file, click 

Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next.  

 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

To import PST file in Microsoft Outlook 2010: 

 Open Microsoft Outlook. From File Menu, select Open -> Import.  

 From Import and Export Wizard window, select Import from another program or file, click 

Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next.  

 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

To import PST file in Microsoft Outlook 2007: 

 Open Microsoft Outlook. From File menu, select Import and Export. 

 From Import and Export Wizard window, select Import from another program or file, click 

Next. 

 In Import a File dialog box, select Personal Folder File (PST), click Next. 



 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In Import Personal Folders dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

  



Save Log Report 

Log Report window displays the log from the beginning of the process to its end along with other 

information like name of file etc. during running of the process. With Stellar DBX to PST Converter, you 

can save the Log Report to analyze the process at a later stage. 

 

To save the log details: 
1. Click on View menu. Select Log Report option. 

2. From Log Report dialog box, click on Save Log option. 

3. Browse for location in Save As dialog box to save the log report at a desired location. Click OK. 

To clear the log details: 
1. Click on View menu. Select Log Report option. 

2. From Log Report dialog box, click on Clear Log option. 

  



FAQs 

1. What does the demo version of the software do? 

In demo version of the software, you can only view and save the subject and body of the mails 

but cannot open any of the mail's attachments. All other fields have DEMO written in it. To view / 

save all data and open attachments, you need to purchase and register the software. 

2. Can I convert a single mail into PST file? 

No. 

3. Can Stellar DBX to PST Converter search for a DBX file location of which is unknown to 

me? 

Yes, you can search for DBX file using Find option present in Select DBX File dialog box. for full 

detail, please refer to Find DBX Files topic of this help. 

4. I want to save converted mails into an existing PST file. How can I do it? 

Stellar DBX to PST Converter gives you option to save converted mails into an existing or new 

PST file. For full details, please refer to Save Converted File topic of this help manual. 

5. Can I convert multiple DBX files simultaneously? 

Yes. But multiple DBX files should be in a single identity folder. Then you can select this identity 

folder for conversion. 

6. Can I convert multiple Identity Folders simultaneously? 

No. 

7. What is the default location of DBX file on my Windows XP system? 

The default location of DBX file on Windows XP system is -> C:\Documents and 

Settings\Administrator\Local Settings\Application Data\Identities\..... 

8. Can I save converted mails to a password protected PST File? 

Yes, absolutely. You can now save converted mails to a password protected PST file using 

Stellar DBX to PST Converter software. By selecting Append data to existing profile / Save 

Data to an existing PST file, you can add data to a password protected PST file as well, by 

simply entering the password when prompted. 

  



Legal Notices 

Copyright 

Stellar DBX to PST Converter software, accompanied user manual and documentation are copyright of 

Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this 

user manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

Copyright © Stellar Information Technology Private Limited. INDIA. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar DBX to PST Converter® is a registered trademark of Stellar Information Technology Private 

Limited.  

Windows Vista®, Windows 7®, Windows 8®, Windows 8.1® and Windows 10® are registered 

trademarks of Microsoft® Corporation Inc. 

MS Outlook Express® and MS Outlook® are registered trademarks of Microsoft® Corporation Inc. 

All Trademarks Acknowledged. 



All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



License Agreement 

Stellar DBX to PST Converter 

Copyright © Stellar Information Technology Private Limited. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar DBX to PST Converter. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar DBX to PST Converter with which this License is included, you may return the 

complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar DBX to PST Converter. For purposes of this License, if you have a valid single-user license, you 

have the right to use a single Licensed Copy of Stellar DBX to PST Converter. If you or your 

organization has a valid multi-user license, then you or your organization has the right to use up to a 

number of Licensed Copies of Stellar DBX to PST Converter equal to the number of copies indicated in 

the documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar DBX to PST Converter may either be used by a single person or used 

non-simultaneously by multiple people who use the software personally installed on a single workstation. 

This is not a concurrent use license. 

All rights of any kind in Stellar DBX to PST Converter, which are not expressly granted in this license, 

are entirely and exclusively reserved to and by Stellar Information Technology Private Limited. You shall 

not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works 

based on Stellar DBX to PST Converter nor permit anyone else to do so. You shall not make access to 

Stellar DBX to PST Converter available to others in connection with a service bureau, application 

service provider or similar business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

http://www.stellarinfo.com/


Stellar DBX to PST Converter and all accompanying software, files, data and materials are distributed 

and provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge 

that good data processing procedure dictates that any program including Stellar DBX to PST Converter 

must be thoroughly tested with non-critical data before there is any reliance on it and you hereby assume 

the entire risk of all use of the copies of Stellar DBX to PST Converter covered by this License. This 

disclaimer of warranty constitutes an essential part of this License. In addition, in no event does Stellar 

authorize you or anyone else to use Stellar DBX to PST Converter in applications or systems where its 

failure to perform can reasonably be expected to result in a significant physical injury or in loss of life. Any 

such use is entirely at your own risk and you would not hold Stellar responsible for any and all claims or 

losses relating to such unauthorized use. 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



About Stellar 

Stellar Data Recovery is a global leader in providing data recovery, data migration and data erasure 

solutions for the past two decades. Stellar Data Recovery is a customer centric, critically acclaimed, 

global data recovery, data migration & erasure solutions provider with cost effective solutions available for 

large corporates, SMEs & Home Users. Stellar Data Recovery is headquartered in New Delhi, India and 

has a strong presence across USA, Europe & Asia. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of Email. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

Data Erasure 

Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently 

erase confidential data beyond the scope of data recovery.  You can perform high speed bulk data 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/file-repair/file-repair-software.php
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
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erasure & generate erasure certificates for audit trail purpose. BitRaser supports 24 International data 

erasure standards. More Info >> 

For more information about us, please visit www.stellarinfo.com 

http://www.stellarinfo.com/data-erasure/data-eraser-windows.php
http://www.stellarinfo.com/

